Creating PDFs. Quark 6-

choose Print when ready to create a PostScript file

F T T 7T 7T T 7 printlayout1 SEERTEE— Print Layout 1
Print Style: | Default 3] i Print Style:  Default )
Copies: 1 Pages: Al ) { Copies: 1 Pages: All 3]
[layout | Setup  Output  Options  Layers  Bleed  Preview Layout | Setwp | Output  Options  Layers  Bleed  Preview
__ Separations _ Spreads Collate | Printer Description Adobe PDF _:]
"!1 Print Blank Pages _ Thumbnails _ Back to Front l Paper Size; Custom T!
Page Sequence:  All 39 . Paper Width 9.5 Paper Offset. 0
Registration: off 3] Offset: Paper Height: 12 (%) Page Gap: 0
Tiling: off 3] overlap: Absolute Overlap Reduce or Enlarge:  100% I Fit In Print Area
I Page Positioning: Center %] Orientation:
( Page Setup... Printer... | Capture Settings Cancel ) ( Print ) ,I (_Page Setup... ) (_Printer... ) ! (_Capture Settings ) (_ Cancel ) (€ Print )
1
Layout: ¢ All boxes unchecked except Print Setup: e Printer Description: Adobe PDF.
Blank Pages. ® Paper Size: Custom.
¢ Page Sequence: All ¢ Page Width & Height: Add 1" to size of
* Registration: Off document. This document size was
e Tiling: Off 8.9" x 11"
¢ Page Positioning: Center.
e Orientation: Choose icon on the left.
Print Layout 1 e C Print Layout 1
Print Style: | Default 3 Print Style: | Default 3]
Copies: 1 Pages: Al 2] Copies: 1 Pages: Al =
Layout | Setup | Output | Options  Layers  Bleed  Preview Layout | Setup  Output | Options | Layers  Bleed  Preview
Print Colors:  Composite CMYK 1% Resolution: 2400 %) (dpi)  Quark PostScript Error Handler
Halftoning r o ) Freauence: [TED ) tod L Page Flip: None 4] [ Negative Print
£ prm | Pl % Halfone ¢ frequency  # Angle & Function Fictiires
& Peskim - 30 3 Defauk Owput | Normal  [§) _ FullRes of Rotated Objects
£ focecmaa - ] i Detauit B ey ) O Overprint £PS Black
OPI: Include Images £J gFuII Resolution TIFF Output
( Page Setup... Printer... ) ( Capture Settings ) ( Cancel ) { Print ) ( Page Setup... | ( Printer... [ Capture Settings ) ( Cancel ) { Print )
Output: e Print Colors: Composite CMYK Options: ¢ Quark PostScript Error Handler:
¢ Halftoning: Conventional. unchecked.
¢ Resolution: 2400 (dpi). ¢ Page Flip: None.
¢ Frequency: 130 (Ipi). ¢ Negative Print: unchecked.

e Output: Normal.

¢ Data: Binary.

¢ OPI: Include Images

e Overprint EPS Black: unchecked.

e Full Resolution TIFF Output: checked.

FORUIM

COMMUNICATIONS PRINTING




Creating PDFs. Quark 6 continued

Print Layout 1

Print Style:  Default w8
Copies: 1 Pages: All l_i_’
i.a\fou(' Setup T Output T Options u_nr: Bleed T Preview
$ Print %,  MName
L Default

__ Apply to Layout
Plates used on selected Layer
No selection

Page Setup... ) ( Printer... | (_ Capture Settings ) ( Cancel

€ print )

e Default
¢ Apply to Layout: unchecked
¢ Plates used on selected Layer: No selection

Layers:

Print Layout 1
Print Style: Default _=|
Copies: 1 Pages: Ail 'I]
Layout | Setup  Output  Options _ Layers _ Bleed | Preview |
Imageable Area Composite: CMYK
W.9.5" Tiles: 1
H12* Scale: 100%
Paper Offset: 0"
Layout Size .
e Page Gap: 0 "‘ R
":;"i‘-ls, Rotation: 0
i Registration: Off
Bleed: Symmetric Align: Center
Amount: 0.25" Negative: No
Reading: Right
Flip: None 0 L
Page Setup... | [ Printer... Capture Settings Cancel |  Print 1
Preview: e Check how the page fits (on the right).

¢ Confirm Layout Size, it should match the
trim size.

¢ Confirm Imageable Area, it should be 1"
larger than Layout Size.

e Select: “Printer” (button on lower left)

Print Layout 1

Print Style: | Default E3)
Copies: 1 Pages: All le
Layout  Setup  Output  Options  Layers | Bleed | Preview
Bleed Type: Symmetric T‘ Amount: .25
E" Clip at Bleed Edge Bottom:
Left:
Right:
| Page Setup... Printer... Capture Settings Cancel ) ( Print ‘
Bleed: ¢ Bleed Type: Symmetric.
e Amount: .25".
¢ Clip at Bleed Edge
(doesn't matter if it is checked or not)
5
Ima Print
W
H: Printer: ~ HP Laserjet 5000 Series1 B3]
Lay
\::? Presets:  Standard 1 3
Blet Output Options ?1
L | n
# save as File Format PostScript =3 4
| ? ( Save As PDF... ) Fax... (" Cancel f Save... ) ¢
Print: e Printer: Choose your PostScript printer.

e Presets: Standard 1.

¢ Select “Output Options”.

¢ Check “Save as File” Format “PostScript”.

¢ Select “Save”.

¢ Choose the location where you want to
save your file.

¢ Name the file your document name with .ps
behind the name you choose.

e Click “Save”

The next step is to distill the PostScript file you just created using Adohe Acrohat Distiller.
See pages 19-24 for Acrobat Distiller 7-9 settings.
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Creating PDFs. Quark 6.5

choose File > Export > Layout as PDF

') Expart as FOF PDF Export Options for Layout 1
sl & e - 5
Sava A5t Froject2_Layour 1.pdf - [ Layeut info job Dptions  Output
- =o urtitled Tolder [ Y :
5C _Eg e e s Title: Layout 1
] Subject:
::: Author: |
Keywords: |
g |
= |
.
Pages: Al 2]
[ Soreads. | Options..

{_Cancel ) ( 0K )

New Falder | (Cancel | {Save )

Export as Layout
PDF: ¢ Specify which pages you would like saved in
the PDF or keep it on “All”
¢ Click “Options”

This is just the name of your file

PDF Export Options for Layout 1

PDF Export Options for Layout 1 3
Layout Info  Hyperlinks | job Options = Output

Layout Info b Job Options. T Qutput
Font Options
I mCkIERSHparings @ Embed all fonts @ subset fonts below: 100%
v Ex
v Compression Options |
v Color Images — 1
X Compression: Automatic ZIP/JPEG Low o)
] Resolution: Downsample to: _3' 300 dpi 1
1 [}
Grayscale Images ]
Compression: Automatic ZIP/JPEG Low 3
Resolution: Downsample to: 14 300 dpi
Monochrome Images
Compression: CCITT Group 4 ?
Resolution: Downsample to: ?‘ 600 dpi
@ Compress Text and Line Art __ ASCIl Format
~ (Gancel) (0N
(Cancel ) E0K=)
- 13 N ” . 11 ”
Hyperlinks: ¢ Uncheck “Include Hyperlinks Job e Font Options: Check “Embed all fonts

Options: Check “Subset fonts below:” 100%

e Color Images: Compression:
Automatic ZIP/JPEG Low

¢ Downsample to: 300 dpi

e Grayscale Images: Compression:
Automatic ZIP/JPEG Low

¢ Downsample to: 300 dpi

¢ Monochrome Images: CCITT Group 4

¢ Resolution: Downsample to: 600 dpi

e Check: Compress Text and Line Art
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Creating PDFs. Quark 6.5 continued

PDF Export Options for Layout 1

- Layout Info = Hyperlinks | Job Options | Dulpul}

Color Output— :
Type: Composite _:]
Print Colors: | CMYK ﬂ

™ Produce Blank Pages

"l Use OPI 1

Images nclude Images !
Registration: Off _:] Offset: & pt

Bleed e

Type: Symmetric ?

Amount: 25"

(Cancel ) 0K

Output:  Color Output
¢ Type: Composite
¢ Print Colors: “CMYK “or if you have a spot
color then choose “Device N”
¢ Uncheck “Use OPI"
Registration: Off
¢ Bleed Type: Symmetric
e Amount: .25"

Click “ok” which brings you back to the Layout as PDF window- then click “save”
and choose where to save your file.
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Creating PDFs. Quark 7-

choose File > Export > Layout as PDF

"Oe Export as PDF
PDF Export Options for Layout 1
Save As: Projectl_Layout 1.pdf g
PDF Style: | Custom Settings 0]
- Em I Desktop M q eation: (e 2]
= T Mame &1 Date Modified
Computer Pages Page Options

% Network Meta Data ! Spreads
Hyperlinks
Compression | Export pages as separate PDFs
Calor & Include Blank Pages
Fonts
Marks — Embed Thumbnall (
Bleed
Layers

i Desktof L Transparency

i
JOF
Summary

" Capture Settings ) (" Cancel ) (ES0KSS)
Pages: Al

@

POF Style: _ Captured Settings

= Pages: e Spreads: unchecked
e Export pages as separate PDF's: click this
on if you want each page as a separate
Export as e Pages: All PDF, otherwise leave unchecked
PDF: e Click the “Options” button ¢ Include Blank Pages: check this box
e Embed Thumbnail: unchecked

New Folder ) ( Cancel ) ( Save _)

PDF Export Options for Layout 1 PDF Export Options for Layout 1

PDF Style: | Custom Settings =] PDF Style: | Custom Settings )
Verification:  None ?! None _E]
Pages Meta Data Pages — Include Hyperlinks

Meta Data ke || 3 Meta Data v Ex y

Hyperlinks T Lot ] lgwellillkl 2

i i . ompression

cator Fohject Color | F

Font: . Fonts

Marks fusha: Marks

Bleed Bleed

e Keywaords: i

Transparency Transparency

onl onl

IoF JOF

Summary Summary

" Capture Sertings " [ Cancel F—M—% ‘" Capture Settings ) [ Cancel ) £ Ok )
Meta Data: e Title: use the name of your file Hyperlinks: ¢ Include Hyperlinks: unchecked

e Subject: can be blank
e Author: your name
e Keywords: leave this blank
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Creating PDFs. Quark 7 Continued

PDF Export Options for Layout 1

PDF Export Options for Layout 1

PDF Style: ~ Custom Settings I3 PDF Style: | Captured Settings ]
Verification:  None 3] Verification:  None )
Pages Color Images Pages Colar Options
Fypertinks Compsasion: {Mneivatic 2PIIEG Lov— ) Mess Dt Mode: | Composite )
gg:;?'““m Bicubic D i) 300 dpi | g:"‘\“?’ﬁ”'“" Setup: | C CMYK (]
or
Fonts Fonts
Marks Grayscale Images Marks = E““"
Bleed - = Bleed — ol
Layers (o ; ZIP/IPEC Low s Layers & Magenta
Transparency = Bicubic D ?! 300 dpl Transparency L Yellow
%r: OPl L Black
! | IDF
Summary Monochrome Images | Summary
Compression; CCITT Croup 4 3] 1
to: 78] soa | dpi
# Compress Text and Line Art Z ascirormat |
7 » 1
Capture Senings ) (__Cancel ) (0K ) | " Capture Settings ) ( Cancel ) (ER0RD)
L
H - - . .
Compression: Color: * Mode: Composite

¢ Color Images: Compression:
Automatic ZIP/JPEG Low
¢ Resolution: Bicubic Downsample to: 300 dpi
¢ Grayscale Images: Compression:
Automatic ZIP/JPEG Low
¢ Resolution: Bicubic Downsample to: 300 dpi
¢ Monochrome Images: CCITT Group 4
¢ Resolution: Downsample to: 600 dpi
¢ Check: Compress Text and Line Art

e Setup: Composite CMYK er Composite

CMYK and Spot (if spot colors are used
in the job)

PDF Export Options for Layout 1

PDF Export Options for Layout 1

PDF Style: | Custom Settings 3] PDF Style: | Custom Settings 3]
Verification:  None _'} Verification: None '?}
Pages Font Options Pages Registration Marks Options
Meta Data & select Al Meta Data Mode: | Off #

Hyperlinks - Hyperlinks e
Compression Download  Font Compression
Colar Colar
Fonts Fonts
Marks Marks.

Bleed Bleed
Layers Layers
Transparency Transparency
ol oM
IDF IDF
Summary Summary

{
" Capture Settings ) [ Cancel ) 0k ) | (" Capture Settings | [ Cancel ) € 0k )

Fonts:

e Font Options: Check “Select All”

Marks:

¢ Registration Marks Options
* Mode: Off
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Creating PDFs. Quark 7 Continued

PDF Export Options for Layout 1

PDF Style: = Custom Settings

)
Werification: None ?]

Pages Bleed Options

Meta Data s (5 i i
fracirhriered Bleed Type. Symmetric _'
Compression Amount 29

Color

Fonts

Marks

Bleed ™ Clip at Bleed Edge

Layers

Transparency

or

1OF
Summary

" Capture Sentings | (" Cancel | 50K

Bleed: ¢ Bleed Options
¢ Bleed Type: Symmetric
e Amount: .25"
e Clip at Bleed Edge: checked

PDF Export Options for Layout 1

PDF Style: | Custom Settings $)

Verification: | None )

Pages Transparency Rendering Options

Meta Data

Hyperlinks Item Resolution

Compression Vector Images e & dpi

el Blends 300 & dpi

Fonts

Marks

E:::s '31 Upsample Rotatlons

Eﬁ"‘“‘""“ To 300  dpi for images less than 200 | dpi

|DF

Summary

— lgnare Transparency Flattening
" Capture Settings | " Cancel ) € 0K )
Transparency:
.

¢ Transparency Rendering Option
Vector Images: 300 dpi
Blends: 300 dpi
Drop Shadows: 300 dpi
¢ Check Upsample Rotations
to 300 dpi for images less than 200 dpi

PDF Export Options for Layout 1

PDF Style: | Custom Settings 2]
Verification: None )
Pages Layer Options
Meta Data # Select All — Apply to Layout
Hyperlinks
Compression Print ", Name
Color “ =] Default
Fonts
Marks
Bleed
Layers
gp-‘:ﬂﬂp-‘ﬂﬂlr Plates used on selected Layer
IDF No selection
Summary

" Capture Settings | [ Cancel ) 0K )

Layers: e Layer Options

e Select All: checked

PD? Exbo'n"bp:ions for Layout 1

POF Style: | Custom Setungs

]
Verification:  None ?'

Papes OFI Options
Meta Data | OPl Active
Hyperlinks
Compression
Color

Fonts

Marks

Bleed

Layers
Transparency
orl

IoF
Summary

" Capture Settings | [ Cancel ) 0K )

OPI: ¢ 0PI Active: unchecked
JDF: ¢ Output JDF: unchecked
Summary: e Just shows a list of all the settings

Click “OK", then when your back to the Export window,
Click “Save”
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Creating PDFs. Quark 8

choose File > Export > Layout as PDF

Export as
PDF:

n Expart as POF
Save As: Creating PDFs 09 E'
Em I Desktop [ Y
& DI4PRODO7 Name & Dare Modified
.
i —
Pages: Al o)
POF Style; | Captured Settings )
("Options... )
# Hide extension | New Folder | (_Cancel ) E Save }
e Pages: All
. " M n
e (Click the “Options” button
PDF Export Options for Layout 1
PDF Style: _Custom Settings []
Verification: | Nope =
Pages Meta Data
Meta Data Title:  Layout |
Hyperlinks 2l
Compression Subject;
Calor <
Fonts [
Authar
Marks
Bleed 3
Keywords.
Layers W
Transparency
oM
1DF
Summary
/" Capture Settings | ( Cancel ) € 0K )

Meta Data: e Title: use the name of your file

e Subject: can be blank
e Author: your name
e Keywords: leave this blank

PDF Export Options for Layout 1

PDF Style: _Custom Settings [ ]
=

Verification: yone

Pages

Meta Data
Hyperlinks
Compression
Color

Fonts

Marks.

Bleed

Layers
Transparency
OPI

IDF

Summary

Page Options
— Spreads
— Export pages as separate PDFs
# Include Blank Pages

— Embed Thumbnail

, -~ ~— |
Capture Settings Cancel oK |

e Spreads: unchecked
e Export pages as separate PDF's: click this
on if you want each page as a separate

PDF, otherwise leave unchecked
¢ |nclude Blank Pages: check this box
e Embed Thumbnail: unchecked

PDF Style

Custom Settings

PDF Export Options for Layout 1

Verification: | ypne

Pages

Mera Data
Hyperlinks
Compression
Calor

Fonts

Marks

Bleed

Layers
Transparency
om

1DF
Summary

14 Ls

_ Include Hyperlinks
v Ex

" Capture Settings ) (| Cancel

.(—"“ ‘

Hyperlinks: ¢ Include Hyperlinks: unchecked
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Creating PDFs. Quark 8 Continued

PDF Export Options for Layout 1

PDF Style; = Custom Settings ™
None 5]
Pages Color Images
Meta Data c : ZIP/IPEG Low %)
Hyperlinks
Compression Bicubic D $] 300 dpi
Color
Fonts
Marks Grayscale Images
Bleed s )
s © : ZIP/IPEG Low :
E’P‘I"“’m"" Bicubic D %) 300  dpl
IoF
Summary Monochrome Images
c CCITT Group 4 %)
Downsample 1o 7% s00  dpl
™ Compress Text and Line Art — ASCI Format
" Capture Settings ) [ Cancel | £ 0K )
Compression:
.

¢ Color Images: Compression:

Automatic ZIP/JPEG Low
¢ Resolution: Bicubic Downsample to: 300 dpi
¢ Grayscale Images: Compression:

Automatic ZIP/JPEG Low
¢ Resolution: Bicubic Downsample to: 300 dpi
¢ Monochrome Images: CCITT Group 4
¢ Resolution: Downsample to: 600 dpi

¢ Check: Compress Text and Line Art

[ PDF Export Options for Layout 1

|

| PDF Style: | Custom Settings TI

: Verification. None I |

| Pages Font Options

| Meta Data & select Al

|  Hyperlinks

| Compression Download Font
Color o B Futura Bold

[ “ Lucida Grande

| Bleed ] Eurastile Condensed

| Layers « Eurostile BoldCondensed

| Transparency Ll Eurastile BoldExtendedTwo
OPl

| oF

| Summary

|

|

|

"_Capture Settings

" Cancel

|
]
|
|

Color:

Fonts:

e Font Options: Check “Select All”

Marks:

PDF Export Options for Layout 1

PDF Style Custom Settings +)

Verification. | None

Pages Calor Options

Meta Data =
Mode:  Ci J

Hypertinks :

Compression Setup: ~ Composite CMYK 3|

Col P P L

Fonts

Marks Hate

Bleed L Cyan

Layers L Magenta

Transparency L Yellow

on #  Black

JoF

Summary

Cancel ( ok )

" Capture Settings | [

¢ Mode: Composite

e Setup: Composite CMYK er Composite
CMYK and Spot (if spot colors are used
in the job)

PDF Export Options for Layout 1

PDF Style: _Custom Settings

3 @

Verification: | None

Registration Marks Options
Mode: | Off 3]

Pages

Meta Data
Hyperlinks
Compression
Color

Fonts

Marks

Bleed

Layers
Transparency
oPl

JOF
Summary

“ Capture Settings | [ Cancel ' £ oK )

¢ Registration Marks Options
* Mode: Off
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Creating PDFs. Quark 8 Continued

PDF Export Options for Layout 1 PDF Export Options for Layout 1

POF Style: _Custom Settings 3]

PODF Style:  Custom Settings T]
3|

Verification: * Nope Verification:  nNgpe

Pages Bleed Options Pages Layer Options

|
|
|
|
Meta Data - . = | | Meta Data @ Select All Apply to Layout
Bleed Type:  Symmetric - —
Hyperiinks L e — | Hyperlinks
E::':?mssmn Amount:  0.25° . | E::'zfprnsstu'l Print £y N
Fonts B | Fomes L = Default
Marks | Marks
Bleed & Clip at Bleed Edge Bleed
Layers | Layers
Transparency | |Transparency Plates used on selected Layer:
oM oP
IoF | oF No selection
Summary | Summary
|
|
|
¢ Capture Settings Y Caneel ) 0D ( Einturt Settings ) (" Cancel ) ‘ oK ,

Bleed: ¢ Bleed Options Layers: e Layer Options
e Bleed Type: Symmetric e Select All: checked
e Amount: .25"
e Clip at Bleed Edge: checked

PDF Export Options for Layout 1 PDF Export Options for Layout 1
PDF Style: | Custom Settings 3] | PDF Style:  Custom Settings 2]

Verification:  None ?' { Verification. ' Nope 3]
Pages Transparency Rendering Options Pages O Options
Meta Data Meta Data — P Active
Hyperiinks Item Resolution Hyperlinks
Compression Vector Images e # dpi Compression
o] Blends 300 % dpi Color
Fonts Fonts
Marks Marks
E:::s '31 Upsample Rotatlons :‘:\;‘:s
Transparency i i G000 | doi Transparency
opl To 300  dpifor images less than 200  dpi Me-
IOF 1DF
Summary Summary

— lgnore Transparency Flattening

" Capture Settings | [ Cancel ) € 0K ) ‘" Capture Settings | " Cancel 1 € Ok )
Transparency: 0PI: ¢ OPI Active: unchecked

e Transparency Rendering Option
Vector Images: 300 dpi JDF: e Qutput JDF: unchecked
Blends: 300 dpi
Drop Shadows: 300 dpi Summary: e Just shows a list of all the settings
e Check Upsample Rotations
to 300 dpi for images less than 200 dpi Click “OK”, then when your back to the Export window,
Click “Save”
¢ |gnore Transparency Flatten:unchecked
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Creating

8. Expest
Save As: Urnitked - 1.pdf =)

<+ [Em test Y
B o7 covmter hane & Dane Madded
3 iwsHD

4 Network

8 wacvoLl

4 Ramgaged

o Fre

- slitEp &

2 Deskrce:

Format: _Adobe POF #
(_ Use Adobe Dialog

( Wew Falder Cancel | {oSave)

Export: e Format: Adobe PDF
¢ Choose the location where you want to
save your file.
¢ Name the file your document name with
.pdf behind the name you choose.
e Click “Save”

Export Adobe PDF

Adobe PDF Preser; FCP (7) new? (modified) 3]
Standard: _None 2] Compatibiliny | Acrobat 5 POF 1.4 18]
Comeral <
Comprin
ekt arc Bessy Sk e -
Outpaut Bicubic Downsampling Lo 78] 300 pixels per inch
el for images above: 450 pixels per inch
[Becuncy : - = &
i Compression: |_Auomatic UPEGI 18] Tie sz 128
Image Quality:  Maximum ]
Grayicale Images
Bicubic Downsampling to 7] 300 pixels pef inch
for images above: 450 plxels per inch
Compression:  Automatic (JPEC) 2] Tile Size: 128
Image Quality:  Maximum ]
Menachrame Images
Bicubic Dawnsampling to 78] 1200  piels per inch

far images above: 1800 pixels per inch
Compression:  CCITT Group 4 8]

™ Compress Text and Line Art ™ Crop image Data to Frames

| Save Preser., Cancel

Compression:

e Color Images: Bicubic Downsampling to 300 for
images above 450 pixels per inch

e Compression: Automatic (JPEG)

e |mage Quality: Maximum

e (rayscale Images: Bicubic Downsampling to 300 for
images above 450 pixels per inch

e Compression: Automatic (JPEG)

e |mage Quality: Maximum

e Monochrome Images: Bicubic Downsampling to
1200 for images above 1800 pixels per inch

e Compression: CCITT Group 4

e Check: Compress Text and Line Art

e Check: Crop Image Data to Frames

PDFs. InDesign CS2

Export Adobe PDF
Adobe POF Preset: | [Press Quality] (modified) ]
standard: _None I} c Acrobat 5 (POF 141 (8]
e Ceneral
Cararusuen <
Wk and Blesch Descriptian: |[Based on ‘[Press Quality Use these sertings o create
S Adobe POF documents best suited for high-guality prepress
s printing. Croated POF documents can be opened with
e Acrobat and Adobe Reader 5.0 and later,
sammary
Pages
San
" Range: 1
— Spreatds
Options
~ Embed Page Thumbnails I View PDF after Exporting
_ Optimize For Fast Web View L
[ Create Tagged POF
Includa
_ Bookmarks _ Mon-Printing Objects
— Hyperlinks | Interactive Elemants
| Visible Guides and Grids o
Save Preser.. | ( Cancel {Expore )

Export PDF General:
e Pages: All.
e Compatibility: Acrobat & (PDF 1.4).
e All boxes are unchecked.

Export Adobe PDF
Adabe POF Preser | [Press Quality) imodified) )
Standard: | Nane 3] Compatibility. | Acrobat § (PDF L4) %]
Coraral Marks and Bleeds
Camprezzan o
ks and Weeds
curut Al Printer’s Masks Type: | Default
Asvasont  Crop Marks : &
‘‘‘‘‘ -  Blend Marks Whight £ 045 04
sumevaiy  Registration Marks Offser: $0.125 in
_ Color Bars
__ Page Information |
Bleed and Slug |
_ Use Document Bleed Sertings i
Bloed |
Tap: +0.25 in Inside: 5 0.25 in |
Bovom: T0.2501n Outside: T0.251n i
~ Include Slug Area
Save Preset.., "~ Cancal ( Ewport )

Marks and Bleeds:
¢ Marks: Leave all unchecked, but make sure
your document is set up to the trim size
with .25" bleeds.
¢ Bleed: .25 in on Top, Inside, Bottom, and
Outside
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Creating PDFs. InDesign €S2 continued

Export Adobe PDF

Adobe PDF Preset:  [Press Quality] imodified) 4]
Standard: | None iC) Compatitility: _Acrobat 5 (PDF 1.4) 3]

Canesal Output

Compression Colaé

Marks and Bheeds

Output Color Conversion:  No Color Conversion _:]

Aty Destination A

Secunty

Sy Profile Inclusion Policy:  Don't Include Profiles _:]

{ Ink Manager...

PDF /X
Output Intent Profile Name
Output Condition Name: N/A
Output Condition Identifier: N/A
Registry Name. N/A

Description

Pasitson the pointer over o heading 16 view 2 descraption.

([ Save Preset... | [ Cancel (: Export )

Output: Color Conversion: No Color Conversion
¢ Profile Inclusion Palicy: Don't Include
Profiles

Export Adobe PDF

Adobe PDF Preset:  [Press Quality] _.1
None ] @ - Acrobat 5 (PDF 1.4) 1 3]
[Caneral Security

ol Encryption Level: High (128-bit RC4) - Compatible with Acrobat 5 and Later
Marks and Bleeds

Oupun Document Open Password

[ Advanced ! Require a password to open the document
Security

Sumeary Document Open Password

Permissions
__ Use a password to restrict printing, editing and other tasks

Permissions Password

Printing Allowed

Changes Allowed

(Save Preser.. ) { Cancel { Export )

Security: ® Don't check any of the boxes

Export Adobe PDF
Adabe PDF Preset: _[Press Quality] imodified) 53]
Standard:  None 53 Compatibility:  Acrobat 5 (FOF 1.4) | %)
General Advanced
Compeassion Fonts
[Marks and Bleads
Output Subset fonts when percent of characters used is less than: 100%
[Advanced 4/ Al fones with appropriate permission bits will be embedded.
| Secunty
summary 0Pl
Omit for OP. _ EPS _ PDF _ Bitmap Images
Transparency Flattener
Preset
Job Definition Format (JDF)
_ Create JOF File Using Acrobat
i/ Requres Adoba Acretar 7. installad. O 3 this epticn
deselects the “Spresds” option in the General panel.
| Save Preser.. | {_ Cancel ) Ex ]

Advanced: e Fonts: Subset fonts when percent of
characters used is less than 100%
¢ OPI: All boxes should be unchecked
¢ Transparency Flattener is grayed out
¢ JDF: Don't check this box

Click Export to
create your PDF file.
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Creating PDFs. InDesign CS3

Export Adobe PDF

Save As: Untiled -1 pdf & =

Adobe POF Preser: | Forum Printing preser imodified) O
= - =7 | € =
= = W Deskion W & Standard: | Mone ¥ Acrohat & (PDF 1.7) v
= DLAPRODOT Harr & D Medibed el General
Campressien
Wk are Bhesd Description: | [Based on 'Farum Printing preser] [Based on ‘Press Quality &
SEar (177 Use these settings to create Adobe POF dacuments
e best sulted far high-quality prepress printing. Created POF
PR |. documents ¢an be opened with Acrobat and Adobe Reader
Semmary
Pages
T O
Range: 1
L Spreads
Optians
_ Embad Page Thumbnails [ wiew POF after Exporting
_ Optimize for Fast Web View _ Create Acrobat Layers
T Create Tagged PDF
Expart Laers: | Visible & Printable Lavers (4]
Include
_ Bookmarks _ Non-Printing Objects
- _ Hyperlinks L interactive Ebements
s L - T visible Guides and Grids 4,
{_Use Adabe Distog |
(e Falder (Caa ) (5w S Freset cance) (S

Export: Under File chose Export Export PDF General:
¢ Format: Adobe PDF e Pages: All.
¢ Choose the location where you want to e Compatibility: Acrabat 8 (PDF 1.7).
save your file. e All boxes are unchecked.
¢ Name the file your document name with
.pdf behind the name you choose.
e Click “Save”

Export Adobe POF Export Adobe POF
Adobe PDF Preset: Forum Printing preset imadified) ) Adabe PDF Preser. Forum Printing preset (modified) 3]
standard: | None 53] Compatibiliny: | Acrobat 8 (PDF 1.7) %] Standard: | None # Compatibilivy: | Acrobat 8 PDF 170 (4]

poee Compression [ Marks and Eloeds
o ot — = —
Oukiaat Bitubic Downsampling 1o #] 300 pinels per inch et — Al Printes’s Marks Type: | Defauit ]
Aebvanced for images above: 450 pixels per inch e £ Crop Marks ht: | 0.3 E1)
wauny : : R e sacanny T tloed Marks i e —
P— I Lomprasson: |- Automatic ¥ Bl . SN Tl surrerary £ | Registration Marks Offset: 5 0.0833 in

Image Quality:  Maximum O | Color Bars

| Page information
Grayscale Images
Bicubic Downsampling 10 T3] 300 pixels per inch Eloed and Slug
for images above: 450 pixels per inch _ Use Document Bleed Settings
= 7o ] S
Compression:  Automatic (JPEC) i Tile Size: 12 Bleed:
: = = e
Deriage Qualky: | Wi i Top: = 0.25 In Inside: = .25 In
Monachrome Images Battom: < 0.25 in Outside: 5 0.25 in
Bicubic Downsampling 10 3] 1200 pinels per inch [l inclisde Shig Area
for images above: 1800  pixels per inch
Compression: | COTT Group 4 4]
# Compress Text and Line Art # Crop image Data to Frames
| Save Preser., Cancel | Export—) i T (_Conel ) EEipens

Compression: Marks and Bleeds:
¢ Color Images: Bicubic Downsampling to 300 for e Marks: Leave all unchecked, but make sure

images above 450 pixels per inch your document is set up to the trim size
e Compression: Automatic (JPEG) with 25" bleeds

e |mage Quality: Maximum , ,

e Grayscale Images: Bicubic Downsampling to 300 for ° Bleeq: .29 in on Top, Inside, Bottom, and
images above 450 pixels per inch Outside

e Compression: Automatic (JPEG)

e |mage Quality: Maximum

e Monochrome Images: Bicubic Downsampling to
1200 for images above 1800 pixels per inch

e Compression: CCITT Group 4

e Check: Compress Text and Line Art

e Check: Crop Image Data to Frames
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Creating PDFs. InDesign CS3 continued

Adobe POF Preset:

Export Adobe PDF

Forum Printing preset (modified)

Standard: ~ None ] Compatibility:  Acrobat 8 (PDF 1.7)
[Caneral Output
[ Compresson Color
Marks and Eleeds
| Durpun Color Conversion:  No Color Conversion _3-7
[ Advanced Destination: .
e P - | Don't Include Profil 5]
oy rofile Inclusion Policy: Don't Include Profiles Iy
Ink Manager... |
PDF/X
Output Intent Profile Name
Output Condition Name: N/A
Output Condition Identifier. N/A
Registry Name: N/A
Description
Position the pointer over a heading to view a descripbon.
(_Save Preser.. |

Cancel o [ Export ) (_ Save Preser.. |

(Marks and EBleeds
Duzpur
Advanced
Secunty

summary

Export Adobe PDF
_:I Adobe PDF Preset:  Forum Printing preset (modified) _:'
3] None ) C ility: | Acrobat B (PDF 1.7) [ 3]
[General Advanced
Compression Fonts

Subset fonts when percent of characters used is less than: 100%

i) Al fones with appropnabe smssdding bits will be snsbedded

oPl
Omit for OPI: _ EPS _ PDF _ Biamap Images

Transparency Flattener

Preset

Job Definition Format (JDF)

_ Create JDF File Using Acrobat
i) mequeres Adabe Acrobar 7.0 Professional or laber to be instalied, Checkang this optian
panel

auteenatically deselects the “Sprands’ optasn in 15w General

Y )

Output: Color Conversion: No Color Conversion

¢ Profile Inclusion Palicy: Don't Include Profiles

Adobe PDF Preset

Export Adobe PDF

Forum Printing preset imodified)

Advanced: e Fonts: Subset fonts when percent of
characters used is less than 100%

¢ OPI: All boxes should be unchecked
¢ Transparency Flattener is grayed out
¢ JDF: Don't check this box

& &

Standard: None T‘ Compatibility: Acrobat 8 (PDF 1.7)
[Caneral Security
| Comprasssnn " 5 . "
e ke Encryption Level: High (128-bit RC4) - Compatible with Acrobat 5 and Later
| Ohtpeat Document Open Password
e — Require a password to open the document
| Sacunity
Sumsary Document Open Password
Permissions
_ Use a password to restrict printing, editing and other tasks
Permissions Password
|"/ s pa d s fegquired pars 1h st in POF ing applican
Printing Allowed
Changes Allowed
v
v
v
(_Save Preset.. |

Cancel { Export )

Security: ® Don't check any of the boxes

Click Export to
create your PDF file.
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Creating PDFs. InDesign C

Save A5 Lncled- 1 pdf

1

<+ [Em B Desktop H Q
B 014PRCoa7 — 1 Dune Wedifies
Farmat: | Adobe POE !
“Hew Falder (Cameat | (52w )

Export:  Under File chose Export

¢ Format: Adobe PDF

¢ Choose the location where you want to
save your file.

¢ Name the file your document name with
.pdf behind the name you choose.

e (Click “Save”

Export Adobe POF

Adobe POF Preser: Forum Printing preset imodified) &
Standard:  None 23] Compatibility: | Acrobat 8 (PDF 1.7) %)

Coeral <
Compreion
—— Color Images =
Ot Bicubic Dewnsampling to #] 300 pixels per inch
et for images above: 450  pixels per inch
sty = s
samman < Automatic UFEG) 8! Tile Size: 128

Image Quality: Maxsmum 3]

Grayicale Images
Bicubic Downsampling to %] 300 pixels per inch
for images above: 450  pixels per inch
[« Automatic (PEG) B Tiesize: 128
Image Quality:  Maxsmum 5]
Menachrame Images
Bicubic Downsampling to T3] 1200  pinels pes inch
for images above: 1800  pixels per inch
Comgression:  CCITT Group 4 (4]
# Compress Text and Line Art # Crop image Data to Frames

Save Preser.

Cancel | [ Expor—)

Compression:

e Color Images: Bicubic Downsampling to 300 for
images above 450 pixels per inch

e Compression: Automatic (JPEG)

e |mage Quality: Maximum

e (rayscale Images: Bicubic Downsampling to 300 for
images above 450 pixels per inch

e Compression: Automatic (JPEG)

e |mage Quality: Maximum

e Monochrome Images: Bicubic Downsampling to
1200 for images above 1800 pixels per inch

e Compression: CCITT Group 4

e Check: Compress Text and Line Art

e Check: Crop Image Data to Frames

S4

Export Adobe PDF

Adobe PDF Preset:  Forum Printing praset (modified)

Standard; | Nane =] (<

Carerad
Eompeannian
ks and Bhn
e

Acrobat 8 (PDF 1.7)

]

General

Dascription” | [Based on Forum Frinting preser| [Based on ‘Press Quality &
1] Use these settings to create Adobe POF documents
bast suited for high-quality prapress printing. Created POF

0

documents can be opened with Acrobat and Adobe Reader

Pages
@Al
_Range: 1
| Spreads

Options

_ Embed Page Thumbnails

| Dptirnize for Fast Web View
! Creame Tagged FDF

=

Expart Layers: | Wisible & Printable Layers 3]

Include

_ Bookmarks

_ Hyperlinks

— Visible Guides and Grids

Multimedea

! Mon-Printing Objects
_Intaractive Elemants

Cancel

_ View POF after Exporting
_ Create Acrobat Layers

)

Export PDF General

e Pages: All.

e Compatibility: Acrabat 8 (PDF 1.7).

e All boxes are unchecked.

Export Adobe PDF

Adobe FOF Preser: | Farum Printing preser (modified)

Acrobat 8 (PDF 1.7}

Standard: | None £ <
Coneral Marks and Bleeds
(o —
Mark
Mk ane ot gl
vty — All Printer’s Marks
[ actianced _ Crop Marks
Sety _! Bleed Marks
Esaaacid | Registration Marks
_ Color Bars.
| Page infarmatian
Bleed and Slug
_ Use Document Eleed Settings
Bleed:
Top: +0.25 in
Bottom: S 0.25 In
__ Include Shug Area
“Save Preset...

Type: | Default
Weight | 0.25 pt
Offser; =+ 0.0833 In

Inside: 0.25in
Outside: = 0.25 In

[
|

Marks and Bleeds:

e Marks: Leave all unchecked, but make sure
your document is set up to the trim size

with .25" bleeds.

¢ Bleed: .25 in on Top, Inside, Bottom, and

QOutside
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Creating PDFs. InDesign €CS4 continued

Export Adobe POF 2 . Export Adobe POF
Adobe POF Preset: | Forum Printing preset tmodified) 1 Adobe PDF Preset:  Forum Printing preset (modified) 3]
Standard: None _:1 C Acrobat 8 (PDF 1.7) 3 Standard: None ] Compatibility: Acrobat 8 (PDF 1.7) =3
[Ceneral Output [Caneral Advanced
Compressson Color Compression Eons
Marks and Eleds Marks and Eleads rom -~
Dutpat Color C i No Color Conversion _21 (utpat Subser fonts when percent of characters used is less than: 100%
Achcra Destination: 1 3 [ Advarced A All fanes with appropriabe embedding bits will be embedded
Secusity . . = Security
L= Profile Inclusion Policy: Don't Include Profiles L Sty Pl
Omit for OPI: _ EPS _ PDF _! Bitmap Images
[_Ink Manager...
Transparency Flattener
PDF/X e
Output Intent Profile Name
Output Condition Name. NfA
Job Definition Format (JDF)
Output Condition Identifier: NfA [ Create JDF File Using Acrobat
Registry Name: N/A &) Requres Adobe Acrobar 7.0 Professional er later o be watalied. Checking this option
automaticalty deselects the “Spreads” aptos m the Ceneral panel.
Description
Mo profies will Be ambadded in the POF. Use thes opuion if the application o output device that will
wse the Adobe POF file doesn't meed to transiate colors smo another codor space.
(_Save Preser... | Cancel ( Export ‘Q { Save Preser.. | - Cancel { Exporr )

Output: Color Conversion: No Color Conversion Advanced: e Fonts: Subset fonts when percent of
¢ Profile Inclusion Palicy: Don't Include Profiles characters used is less than 100%
¢ OPI: All boxes should be unchecked
¢ Transparency Flattener is grayed out
¢ JDF: Don't check this box

Export Adobe PDF
Adobe PDF Preset: Forum Printing preset i _:1
Standard: ' None Y| Compatibility: ~Acrobat 8 (PDF 1.7) | 3]
[Ceneral Security
it Encryption Level: High {128-bit RC4) - Compatible with Acrobat 5 and Later
Marks and Eleds
| Owtp Document Open Password
[Ackivcad _ Require a password to open the document
security
Sumeary Document Open Password

parmisions Click Export to

_ Use a password to restrict printing, editing and other tasks

create your PDF file.

jp ™is pa i 15 mequired to eoes the document in POF esiting applicat
Printing Allowed
Changes Allowed
v
v
v

( Save Preset... | Cancel (:Elnol‘t—;

Security: ® Don't check any of the boxes
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Creating PDFs.

save A st pat 1&

Ba

& Dume Wadified

[« v | (5= m| [EDeskon

DIVICES n Hame.

SHARED
PLACES
[ - B !

Formas: | Adche PDF {Frint) =

( Maw Foidar (Cancel ) (_Sav )

Export:  Under File chose Export

e Format: Adobe PDF

InDesign CS

Adobe POF

Adobe POF Preser: | [High Quality Print] imodified)

+

Standard: | Nane B [ Acrabat §/9 (PDF 1.71 %]

Frey General
Compraian
Mk and Sinach Description: [Based on ‘[High Quality Print]'] Use these semings to create
T Adabe POF documents for quality printing an desktop
FPEEsE printers and procfers, Created PDF documents can be
Sacury ‘opened with Acrobat and Adobe Reader 5.0 and later.
Surmerary

Pages

= an

O Range: 1

! Spreads

Options

" Embed Page Thumbnails
| Optimize for Fast Web View
_| Create Tagged POF

I Viow PDF after Exparting
_| Create Acrobat Layers

Export Layers: | Visible & Printable Layers (4]

Include —
| Bookmarks
! Hyperlinks

! Nan-Printing Objects
| visible Guides and Grids

Interactive Elements: | Do Not Include :

{ Save Preset..

Export PDF General:
e Pages: All.

{ Canest ) {

¢ Choose the location where you want to
save your file.

¢ Name the file your document name with
.pdf behind the name you choose.

e Click “Save”

e Compatibility: Acrobat 8/9 (PDF 1.7).
e All boxes are unchecked.

Expart Adobe PDE Expart Atiabe POF
Adabe PDF Preset: | {High Quality Print] imodified) ] Adobe POF Preset. | [High Quality Prinn] (modified) )
standard: | Wone L] c Acrobat B/9 (FDF 1.7} 18 Standard: | Mone 2] Compatibility: | Acrobat 8/9 (PDF 1.7 18]
o € r— Marks and Bleads
Camprasar Comaress o
Wit ared Beeihs (.o..n( |"|l_9¢5 il ki [vrtcr are Bimnss el
et Bicubic Downsampling 1o T8l 300 pixels per inch — LAl Pririer's Marks. Type: | Default ]
ruascet far images abave: 450 piels per inch e C Crop Marks weighe: (5255 )
e ca ion: | Automatic JPEG) W Te size: 128 . I Mase Harke
BRI mpression. | Automatic (PE +H e Size Sammay [ Registration Marks Offser: - 0.0833 in
Image Quality. | Maximum 2] . Color Bars
L Page Information
Grayscale Images
Bicubic Downsampling to T3] 300 pixels per nch Bleed and Slug -
far images above: 450 pixals per inch [ Use Document Bleed Settings
€ Automatic UPEC) — W Thesize: 128 e
Image Quality: | Maximum D Top: =0.25 In Inside: 0,25 In
Manachrome Images Bottom: £0.25 in Dutside: 5 0.25 in
| Bicubic Downsampling ta T8] 1200 pinels per ineh O ickide Sy Area
for images above: 1800  pixels per inch :
Compression: | COITT Group 4[]
™ Comprass Text and Line Art | €rop Image Data ta Frames

Save Preset... { Cancel )

( Sawe Preser., |

Marks and Bleeds:
¢ Marks: Leave all unchecked, but make sure
your document is set up to the trim size
with .25" bleeds.
¢ Bleed: .25 in on Top, Inside, Bottom, and
Outside

) (Cancal

) (Empore )

Compression:

e Color Images: Bicubic Downsampling to 300 for
images above 450 pixels per inch

e Compression: Automatic (JPEG)

e |mage Quality: Maximum

e (rayscale Images: Bicubic Downsampling to 300 for
images above 450 pixels per inch

e Compression: Automatic (JPEG)

e |mage Quality: Maximum

e Monochrome Images: Bicubic Downsampling to
1200 for images above 1800 pixels per inch

e Compression: CCITT Group 4

e Check: Compress Text and Line Art

e Don't Check: Crop Image Data to Frames
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Creating PDFs. InDesign CS5 continued

Export Adobe PDF
Adobe PDF Preset: | [High Quality Print] i ] -6]
Sundurd: (None 8] 2 . (Acrobat 8/9 60F 1.7)_18)
Ceneral Output
[Compression - Color
[Marks and Blaads
uetput Color C Mo Color Conversion B
Advanced Destination: N/A .
| Security " . . 3
i Profile Inclusion Policy: | Don't Include Profiles T]

=
Simulate Overprint { Ink Manager... |

= PDF/X
Output Intent Profile Name: | N/A
Output Condition Name: N/A
Output Condition Identifier: N/A
Registry Name: NjA

Description
Position the pointer over 2 heading to view 3 description.

( Save Preset...

( Cancel ) ( Exporr )

Adobe PDF Preser: | [High Quality Print] dified 3
dard: | None 2] Compatibility: | Acrobat 8/9 (FDF 1.7) 18]

Canarat Advanced

Compression

Marks and Blesds [Frems ——

 Dutgeat Subset fonts when percent of characters used is less than: 100%

(Advanced A Al fonts with appropeiate embedding bits will be embedded.

Security : !

sumemary el 1

Omit for OP1: _|EPS | PDF | Bitmap Images

— Transparency Flattener 1
Preset: | [High Resolution] .

Ignore Spread Overrides

|~ Job Definition Format JDF)

[ Create JDF File Using Acrobat

Bequires Adobe Acrobat 7.0 Professional or later to be installed. Checking this aption
automatically desebects the “Spreads” oplios in the General panel.

Output: Color Conversion: No Color Conversion

¢ Profile Inclusion Palicy: Don't Include Profiles

Export Adobe PDF
Adobe PDF Preset: | [High Quality Print] lified| Tj
‘None eS| (e - [ Acrobat 8/9 (POF 1.7) 15
Ceneral Security
o Encryption Level: High {128-bit AES) - Compatible with Acrobat 7 and Later
Marks and Blesds
[ — Document Open Password
Adumicad _| Require a password to open the document
Sacurity
 Summary Document Open Password

Permissions
| Use a password to restrict printing, editing and other tasks

Permissions Password.

J This naiword i required 1o spem the documant in POF sditing applican
Printing Allowed:  High Resolution .
Changes Allowed:  Any except extracting pages .

+ Enable copying of text, images and other content
v Enable text access of screen reader devices for the visually impaired

¥ Enable plaintext metadata

T — e
Save Preset.. | { cancel ) [ Ewpomt )

Security: ® Don't check any of the boxes

o

(" Save Preser...

[ cancel ) [ Expomt )

Advanced: e Fonts: Subset fonts when percent of

characters used is less than 100%
¢ OPI: All boxes should be unchecked
¢ Transparency Flattener is grayed out
¢ JDF: Don't check this box

Click Export to
create your PDF file.
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Acrobat Distiller

Acrobat 7

General:

Adobe POF Settings: Press Quality(1)
[ General | Images Fomts  Color

Description

Use these settings to create Adobe POF documents best suited for high-
guality prepress printing. Created PDF¥ documents can be opened with
Acrobat and Adobe Reader 5.0 and later.

Settings.

Adobe POF Settings: Press Quality(1)
General | Images | Fonts  Color A d
Color Images

Sampling:  Bicubic Downsampling to T8 300 pixels per inch

for Images above: 450 pixels per inch

[ : | Autamatic (PEG) )
File Options = i
c ibility: Acrobat 7.0 (PDF 1.6)  [#) mage Hlie L Maxkmem
Grayscale Images
Object-Level Compression:  Off T‘ " 2 =
B I | H I
Auto-Rotate Pages: | Off 7] Sampling: Bicubic Downsamplingte "% 300 pixals per inch
EBinding:  Left 7] for images above: 450 pixels per inch
Compression: _Automatic JPEG) 1]
Resolution: 2540 dots per inch
@ All Pages Image Quality:  Maximum [ 5]
Pages From; T
i | Monochrome Images
_ Embed Thumbnails o
) Optimize For Fast Web View Sampling;  Bicubic Downsampling to ¥] 1200  pinels per inch
Default Page Size for images above: 1800  pinels per inch
Units: | Inches ) s SR )
Anti-Alias to gray: | Off ?
Width:  9.5000 Height: 12| (CPamey.
Save As. Help (cancel ) (50K Save As.. Help Cancel ) (50K

e Compatibility: Acrabat 7.0 (PDF 1.6). Images: e Color Images: Sampling: “Bicubic Downsampling to
e Object-Level Compression and Auto-Rotate 300 pixels per inch for images above 450 pixels per inch.
Pages: Off e Compression: Automatic (JPEG) Image quality: Maximum
T e (Grayscale Images: Sampling: “Bicubic Downsampling
e Binding: Left. : : . .
. to 300 pixels per inch for images above 430 pixels per
* Resolution: 2540 inch.
* Distill Pages: All e Compression: Automatic (JPEG) Image quality: Maximum
¢ Don't check: “Embed Thumbnails” and e Monochrome Images: Sampling: “Bicubic
“Optimize For Fast \Web View” Downsampling to 1200 pixels per inch for images
e Default Page Size: Should be 1” larger than above 1800 pixels per inch.
trim size e Compression: CCITT Group 4
e Anti-Alias to gray: Off
Adobe PDF Seatings: Press Quality(1) Adobe PDF Settings: Press Quality(l) z
General ﬂeues__ﬁmu ﬂ_ Advanced __Standards General  Images  Fonts | Color | Advanced  Standards
™ Embed all fants
¥ Embed OpenType fonts Astohe:Colox Setl g »
M subset embedded fonts when percent of characters used is less than: 100 % Settings File: | None _:]
Q) Only fonts with approp PN 1% esaded Color Management Policies
‘When embedding fails:  Cancel job 2]
Embedding Leave Color Unchanged T‘
[Users prefight/Library/F 3 S ot Document Intent: | Preserve 3]
oo Working Spaces
[ Add-> | Cray.
i RCE:
P:’ Embed F iz
v pre
ek
| Device-Dependent Data
: ' Preserve Under Color Removal and Black Generation
(= I When transfer functions are found: Remove T’
“Add Name “Remove  Preserve Halftone Infarmation
Save As Help (" Cancel ok \ | Save As.. | Help Cancel f_ o ]
Fonts: e Check: Embed All Fonts Color: e Settings File: None.

e Embed OpenType fonts

e Check: Subset Embedded Fonts When
Percent of Characters Used is Less Than:
100%

¢ \When Embedding Fails: Gancel Joh

e Color Management Palicies: Leave Color
Unchanged (Your document should only contain

CMVYK colors and images hefore distilling the PostScript file.)

¢ Rendering Intent: Preserve

e Check: Preserve Under Color Removal and Black
(Generation

¢ \When Transfer Functions are found: Remove

¢ Don't check: Preserve Halftone Information
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Acrobat Distiller Settings.

Acrobat 7 continued

Adobe PDF Settings: Press Quality(1)
General Images  Fonts  Color | Advanced | Standards

Options

W Allow Post5cript file to override Adobe PDF Settings
[ Allow PostScript XOhjects
W Convert gradients to smooth shades
"I Convert smooth lines to curves
W Preserve Level 2 copypage semantics
@ Preserve Overprint Settings
Eﬂverprinting default is nonzero overprinting
@Save Adobe PDF Settings inside PDF file
W save original JPEG images in PDF if possible
| Save Portable Job Ticket inside PDF file
[ Use Prologue.ps and Epilogue.ps

| Create Job Definition Format (JDF) file

Document Structuring Conventions (DSC)

@ Process DSC comiments
" Log DSC warnings
E,ﬁ Preserve EPS information from DSC
"I Preserve OPl comments
EPrESEWE document information from DSC

W Resize page and center artwork for EPS files

k\' SavEAS...;.' .___' Help ) ( Cancel -( 0K

%

Advanced:
e Options: Check all boxes except “Allow
PostScript XObjects”, “Convert smooth lines
to curves”, “Save Portable Job Ticket
inside PDF file", “Use Prologue.ps and
Epilogue.ps” and “Create Job Definition
Format (JDF) file”

¢ Document Structuring Conventions (DSC):
Check all boxes except “Log DSC Warnings”
and never check “Preserve 0Pl Comments”.

Standards: You do not need to change anything in this tab
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Acrobat Distiller Settings.
Acrobat 8

Adobe PDF Settings: Forum Printing preset - Adobe POF Settings: Forum Printing preset
[ General = Images Fonts Color Advanced  Standards : General | Images | Fonts Color  Advanced  Standards
Color Images
Description
Sampling: | Bicubic Downsampling to 18] 300 | pixels per inch
[Based on "Press Quality(1)] Use these settings to create Adobe PDF ]
documents best suited for high-quality prepress printing., Created PDF for images above: 450 pixels per inch
documents can be opened with Acrobat and Adobe Reader 5.0 and Later. i Automatic PEG) 2]
File Oprions R
I ality:  Maximum  ©§
¢ bility: _Acrobat 8.0 (POF 1.7) 1% RS Naninun I
Grayscale Images
Object-Level Compression: Off ) % =
I i i 0 {] [
Auto-Rotate Pages:  OFf 3] SR Senbic DverboEng oI 300 RISENS ek
- i fi ; {] [
Binding: | Left 3 : for images above: 450 pixels per inch
Compression: | Automatic (JPEG) )
Resolution: 2540 dots per inch 5 Avomatie (pecr B
@) A1l Pages Image Quality: | Maximum 3]
_ Pages From: To:

Monochrome Images
_ Embed Thumbnails
Optimize For Fast Web View ] Sampling:  Bicubic Downsamplingto '] 1200  pixels per inch

Default Page Size for images above: 1800 pixels per inch

Units:  Inches B3] £ : ELIL !
Anti-Allas to gray:  Off T1
Width; 95000 Helght:  12}0000 (Poliey
(Saveds. ) ( vew ) ( Cancel ) (00N Save s ) Help Cancel ) (oK)
General: e Compatibility: Acrobat 8.0 (PDF 1.7). Images: e Color Images: Sampling: “Bicubic Downsampling to
e Object-Level Compression and Auto-Rotate 300 pixels per inch for images above 450 pixels per inch.
Pages: Off e Compression: Automatic (JPEG) Image quality: Maximum

e (Grayscale Images: Sampling: “Bicubic Downsampling
to 300 pixels per inch for images above 430 pixels per

e Binding: Left.
e Resolution: 2540

inch.
e Check: All Pages e Compression: Automatic (JPEG) Image quality: Maximum
¢ Don't check: “Embed Thumbnails” and e Monochrome Images: Sampling: “Bicubic
“Optimize For Fast Web View” Downsampling to 1200 pixels per inch for images

* Default Page Size: Should be 1" larger than above 1800 pixels per inch.
e Compression: CCITT Group 4

trim size o
e Anti-Alias to gray: Off
L Adabe PDF Settings: Forum Printing preset | i Adobe PDF Settings: Farum Printing preset
| General  Images | Fonts | Color  Advanced  Standards i General  Images  Fonts | Color | Advanced  Standards

W Embed all forts

Adobe Color Settings
™ Embed OpenType fonts 4

| subset embedded fonts when percent of characters used i less than: 100 % | Settings File: | None 2] 1
D Only fonts with bits will be dded Color Management Policies
| When ing fails: | Cancel job ) =
Embedding Leave Calor 2]
[Users/ preflight/Library/F %) P Ry ' dering Intent; | Preserve &)
Font Sowrce

Woarking Spaces

( Add-> Cray:
|
| RGE: |
= L CMYK:
Neves Embed Fane
v
(_Add->
Device-Dependent Data
| ¥ Preserve Under Color Removal and Black Generation
| =] i When transfer functions are found:  Remove -+
(AddName.. ) | Remove _! Preserve Halftone Information
| i s
(Saveds.. ) ( hHelp ) [ Cancel ) 0K el Halp ) (_Cancal ) (50K

Fonts: e Check: Embed All Fonts Color: e Settings File: None.
e Check: Embed OpenType fonts ¢ Color Management Palicies: Leave Color

e Check: Subset Embedded Fonts When Unchanged (Your document should only contain
Percent of Characters Used is Less Than: CMYK colors and images hefore distilling the PostScript file.)

100% ¢ Rendering Intent: Preserve
e When Embedding Fails: Cancel Job o EZﬁgtgggﬁserve Under Color Removal and Black
¢ \When Transfer Functions are found: Remove
¢ Don't check: Preserve Halftone Information
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Acrobat Distiller Settings.

Acrobat 8 continued

Adobe PDF Settings: Forum Printing preset

General  Images  Fonts  Color | Advanced | Standards

Options
W Allow PostScript file to override Adobe PDF Settings
" Allow PostScript XObjects
W Convert gradients to smooth shades
"I Convert smooth lines to curves
™ Preserve Level 2 copypage semantics
@ Preserve Overprint Settings
Eﬂverprinting default is nonzero overprinting
@Save Adobe PDF Settings inside PDF file
W save original JPEG images in PDF if possible
" | save Portable Job Ticket inside PDF file
"l Use Prologue.ps and Epilogue.ps

Document Structuring Conventions (DSC)

@Pmcess Ds5C comments
" Log DSC warnings
@ Preserve EPS information from DSC
" IPreserve OPl comments
@ Preserve document information from DSC
™ Resize page and center artwork for EPS files

.\ Save As__ '__.I k_' Help ) I Cancel '( 0K

Advanced:
e Options: Check all boxes except “Allow
PostScript XObjects”, “Convert smooth lines
to curves”, “Save Portable Job Ticket
inside PDF file", “Use Prologue.ps and
Epilogue.ps”

¢ Document Structuring Conventions (DSC):
Check all boxes except “Log DSC Warnings”
and never check “Preserve 0Pl Comments”.

Standards: You do not need to change anything in this tab
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Acrobat Distiller Settings.
Acrobat 9

Adobe POF Setings: Press Quality(1) Adobe POF Settings: Press Quality(l)
| General  Images  Fonts  Color  Advanced  Standards ) General | Images Fonts  Color  Advanced  Standards
Color Images
Deseription Sampling:  Bicubic Downsampling to +! 200 pixels perinch
Use these settings 1o create Adobe POF documents best suited for high-
quality prepress printing. Created POF documents can be opened with
Acrobat and Adobe Reader 5.0 and later.

forimages above: 450 pixels per inch

Comprassian; | Autamatic (PEG) 2]
File Options
: 7o |
[ % H
C { Acrobat 8.0 (PDF 1.7) TSRt L M
Grayscale Images
Object-Level C: i on

Sampling: = Bicubic Downsampling 1o 7] 300 pixels per inch

Auto-Rotare Pages:  OFff

for images above: 450 pixels per inch

Binding: Left = it
: Compression: Automatic PEG) +
Resolution: 2540 dots per inch —_——— ]
‘E‘AII Pages Image Quality:  Maximum 3]
! Pages From: To:

Manachrome Images

| Embed Thumbnails i
| Oprimize For Fast Web View Sampling: Bicubic Downsampling to 3] 1200  pixels perinch

= for images above: 1500 ixels per inch
Default Page Size 9 P p

N — e e
Width: 9.5000 Height: 12 Policy )
e —-HE-";— EE;(E‘ {T] (“save s, ) Help | Cancel | o)
General: e Compatibility: Acrobat 8.0 (PDF 1.7). Images: e Color Images: Sampling: “Bicubic Downsampling to
e Object-Level Compression and Auto-Rotate 300 pixels per inch for images above 450 pixels per inch.
Pages: Off e Compression: Automatic (JPEG) Image quality: Maximum
e Bindina: Left e (Grayscale Images: Sampling: “Bicubic Downsampling
. Resoluqc.ion' 2'5 40 to 300 pixels per inch for images above 430 pixels per
' inch.
* Distill Pages: All e Compression: Automatic (JPEG) Image quality: Maximum
¢ Don't check: “Embed Thumbnails” and e Monochrome Images: Sampling: “Bicubic
“Optimize For Fast \Web View” Downsampling to 1200 pixels per inch for images

* Default Page Size: Should be 1" larger than above 1800 pixels per inch.
e Compression: CCITT Group 4

e Anti-Alias to gray: Off
Adobe POF Settings: Press Quality(l) Adobe POF Sertings: Press Cuality(1)
General  Images = Fonts  Color  Advanced d General  Images  Fonts | Color  Advanced
@ Embed all fonts
= Adobe Color Settings
¥ Embed OpenTypa fonts -
@ Subser embedded fonts when percent of characters used is less than: 100 % Sottings File:  None
D Only fonts with approp SIS Do St vl Color Managemant Policies
When embedding fails:  Cancel job H —
Embedding Leave Color L 34
Users jaysioh0/Lbrary/F (] L Document Rendering Intent: | Preserve )
Fomt Source
Waorking Spaces
Add-> | Gray:
RGE:
i€ CMYK:
Mewer Embed Font
v
Add->
Device-Dependent Data
@ Preserve Under Color Removal and Black Generation
= % When transfer functions are found: | Remave )
Add Name... | ( Remowe ) — Presenve Halfione Information
Save As.. Help (Cancel ) (0N (Saveds... Help ) ([ Cancel ) E=0K)

Fonts: e Check: Embed All Fonts Color: e Settings File: None.
e Check: Embed OpenType fonts ¢ Color Management Palicies: Leave Color

e Check: Subset Embedded Fonts When Unchanged (Your document should only contain
Percent of Characters Used is Less Than: CMYK colors and images hefore distilling the PostScript file.)

100% e Rendering Intent: Preserve
e When Embedding Fails: Cancel Job o gzﬁgtgggﬁserve Under Color Removal and Black

¢ \\Vhen Transfer Functions are found: Remoue
¢ Don't check: Preserve Halftone Information
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Acrobat Distiller Settings.

Acrobat 9 continued

Adobe POF getti.ngs: Press Qualit;'-li.l}
General Images  Fonts  Color | Advanced | Standards

Options
W Allow PostScript file to override Adobe PDF Settings
" Allow PostScript XOhjects
@ Convert gradients to smooth shades
" Convert smooth lines to curves
W Preserve Level 2 copypage semantics
@ Preserve Overprint Settings
' v Overprinting default is nonzero overprinting
@Save Adobe PDF Settings inside PDF file
@ Save original JPEG images in PDF if possible
I save Portable Job Ticket inside PDF file

Use Prologue.ps and Epilogue.ps

Document Structuring Conventions (DSC)

! Process DSC comments
[ Log DSC warnings
@ Preserve EPS information from DSC
" | Preserve OPl comments
EPTESE!’UE document information from DSC

@ Resize page and center artwork for EPS files

( save As... ' ( Help :,- (" Cancel ',I( 0K

Advanced:
e Options: Check all boxes except “Allow
PostScript XObjects”, “Convert smooth lines
to curves”, “Save Portable Job Ticket
inside PDF file", “Use Prologue.ps and
Epilogue.ps”

¢ Document Structuring Conventions (DSC):
Check all boxes except “Log DSC Warnings”
and never check “Preserve 0Pl Comments”.

Standards: You do not need to change anything in this tab
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